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Note to the Author
[This document is a template of a Test Plan document for a project. The template includes instructions to the author, boilerplate text, and fields that should be replaced with the values specific to the project.

· Blue italicized text enclosed in square brackets ([text]) provides instructions to the document author, or describes the intent, assumptions and context for content included in this document.
· Blue italicized text enclosed in angle brackets (<text>) indicates a field that should be replaced with information specific to a particular project.
· Text and tables in black are provided as boilerplate examples of wording and formats that may be used or modified as appropriate to a specific project.  These are offered only as suggestions to assist in developing project documents; they are not mandatory formats.

When using this template for your project document, it is recommended that you follow these steps:
1. Replace all text enclosed in angle brackets (e.g., <Project Name>) with the correct field values. These angle brackets appear in both the body of the document and in headers and footers.  To customize fields in Microsoft Word (which display a gray background when selected):
a. Select File>Properties>Summary and fill in the Title field with the Document Name and the Subject field with the Project Name.  
b. Select File>Properties>Custom and fill in the Last Modified, Status, and Version fields with the appropriate information for this document. 
c. After you click OK to close the dialog box, update the fields throughout the document with these values by selecting Edit>Select All (or Ctrl-A) and pressing F9.  Alternatively, you can update an individual field by clicking on it and pressing F9. This must be done separately for Headers and Footers.
2. Modify boilerplate text as appropriate to the specific project. 
3. To add any new sections to the document, ensure that the appropriate header and body text styles are maintained.  Styles used for the Section Headings are Heading 1, Heading 2 and Heading 3.  Style used for boilerplate text is Body Text.
4. To update the Table of Contents, right-click and select “Update field” and choose the option- “Update entire table”
5. Before submission of the first draft of this document, delete this “Notes to the Author” page and all instructions to the author, which appear throughout the document as blue italicized text enclosed in square brackets.]
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NOTE: If project teams are using automated tools to track and document testing activities, it is acceptable to substitute tool-generated test result reports if they meet the information requirements of the PPM template.
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[bookmark: _Toc292181763][bookmark: _Toc292181764][bookmark: _Toc292181765][bookmark: _Toc292181766][bookmark: _Toc292181781][bookmark: _Toc364331553][bookmark: _Toc364331696][bookmark: _Toc364331554][bookmark: _Toc364331697][bookmark: _Toc364331555][bookmark: _Toc364331698][bookmark: _Toc364331556][bookmark: _Toc364331699][bookmark: _Toc364331557][bookmark: _Toc364331700][bookmark: _Toc364678707][bookmark: _Toc364678747][bookmark: _Toc364331558][bookmark: _Toc364331701][bookmark: _Toc364678708][bookmark: _Toc364678748][bookmark: _Toc364331559][bookmark: _Toc364331702][bookmark: _Toc364678709][bookmark: _Toc364678749][bookmark: _Toc364331560][bookmark: _Toc364331703][bookmark: _Toc364678710][bookmark: _Toc364678750][bookmark: _Toc391920678][bookmark: _Toc237919290]Introduction
[bookmark: _Toc237919289][bookmark: _Toc391920679][bookmark: _Toc105907880][bookmark: _Toc106079190][bookmark: _Toc106079515][bookmark: _Toc106079784][bookmark: _Toc107027560][bookmark: _Toc107027770]Purpose
[bookmark: _Toc238536487][bookmark: _Toc280010256][bookmark: _Toc384289372][bookmark: _Toc72818513][bookmark: _Toc292109360]This <Project Name> Test Plan provides a summary of the results of test performed as outlined within this document.

[bookmark: _Toc391920680]Resource Requirements
<Identify the equipment and personnel resources required to perform the testing identified within the scope of this document.>
[bookmark: _Toc238536488][bookmark: _Toc283727371][bookmark: _Toc384289373][bookmark: _Toc391920681]Testing Environment
<Describe the testing environment needed to test the components identified in this document. Include names, locations, availability, and any specific configuration or version requirements of the identified equipment.>
[bookmark: _Toc238536489][bookmark: _Toc283727372][bookmark: _Toc384289374][bookmark: _Toc391920682]Other Testing Components
<List other components needed to support testing; these components are not part of the solution being tested. Include testing programs/devices and programming aids as well as which components must run in parallel with the new solution to achieve functionality.>
[bookmark: _Toc238536490][bookmark: _Toc283727373][bookmark: _Toc384289375][bookmark: _Toc391920683]Personnel Roles and Responsibilities
<Identify the groups required to perform the tests successfully. Include any special requirements, such as multiple-shift operation or key personnel.>
	Role/Function
	Necessary Skills 
(Experience, Tool Sets, Etc.)
	Responsibilities 

	Project manager
	
	

	Test lead
	
	

	Configuration manager
	
	

	Quality assurance team member
	
	

	Database administrator
	
	

	Enterprise architect
	
	

	Network administrator
	
	

	IT security specialist
	
	

	User testers
	
	


[bookmark: _Toc294708667]Table 1 - Personnel Roles and Responsibilities
[bookmark: _Toc283727374][bookmark: _Toc384289376][bookmark: _Toc391920684]Testing Schedule
<Identify the schedule of all tests including milestones, reviews, and resources. Reference the Project Schedule (WBS), if applicable.>
[bookmark: _Toc283727375][bookmark: _Toc384289377][bookmark: _Toc391920685]Staff Training
<Identify the types of training and personnel to be trained. Reference the Training Plan, if applicable.>
[bookmark: _Toc294708438][bookmark: _Toc294708836][bookmark: _Toc294724124][bookmark: _Toc294724294][bookmark: _Toc294724458][bookmark: _Toc384289378][bookmark: _Toc391920686][bookmark: _Toc238536492][bookmark: _Toc280010258]Assumptions, Constraints, and Risks 
[bookmark: _Toc238536493][bookmark: _Toc283727377][bookmark: _Toc384289379][bookmark: _Toc391920687]Testing Assumptions
<Identify the assumptions made regarding the solution being tested. Include assumptions related to items such as equipment availability, resource skills, code availability, and data availability.>
[bookmark: _Toc238536494][bookmark: _Toc283727378][bookmark: _Toc384289380][bookmark: _Toc391920688]Testing Constraints 
<Identify the constraints that affect the testing. Include constraints related to items such as availability of equipment, trained staff, and compressed project schedule.>
[bookmark: _Toc238536495][bookmark: _Toc283727379][bookmark: _Toc384289381][bookmark: _Toc391920689]Project-Level Testing Risks
<Identify the risks associated with the testing activities. Include a work around or mitigation plan for each of the identified risks and document the risks within the Risk Management Log.>


[bookmark: _Toc384289382][bookmark: _Toc391920690][bookmark: _Toc238536496][bookmark: _Toc280010260]Testing Approach 
<Outline the overall approach for testing the system features. Describe the measures taken to ensure that all aspects of the system are successfully tested and can be implemented. Document the content, methodology, and progression of test activities. 
For example:
Will some unit and integration testing be done and then more development?
Is a prototype being built that will be tested for usability before the releasable software is developed?
Also, include plans for testing of documentation (e.g. installation instructions, User Manual, Operations and Maintenance Manual, training artifacts)
Use Sections 4 and 5 in this document to provide a detailed description of the test approaches.
Note: Once the system/application satisfies all of the unit/system/integration and user acceptance testing then it is ready for deployment activities, which involve submitting it for production to the HUD Test Center. The HUD Test Center can be considered the front-end of the deployment process. In addition to providing release documentation, the purpose and value of the Test Center’s testing is to assure that:
· The deployment will work in HUD-standard environment/configuration;
· The production installation instructions are complete and correct;
· The files to be deployed are available and correct.>
[bookmark: _Toc294708445][bookmark: _Toc294708843][bookmark: _Toc294724131][bookmark: _Toc294724301][bookmark: _Toc294724465][bookmark: _Toc294708496][bookmark: _Toc294708894][bookmark: _Toc294724182][bookmark: _Toc294724352][bookmark: _Toc294724516][bookmark: _Toc384289383][bookmark: _Toc391920691]Methodology
<Describe the general methodology or testing strategy for each type of testing described in this Test Plan.>
[bookmark: _Toc384289384][bookmark: _Toc391920692]Test Progression/Order
<Describe the manner in which progression is made from one test to another, so the entire cycle is completed.>
[bookmark: _Toc384289385][bookmark: _Toc391920693]Test Milestones
<List the testing milestones. Refer to the Project Schedule if applicable. 
Some key elements to consider in developing test milestones are:
Readiness of the product to be tested 
Readiness of the test environment
Readiness of the test team for a transition from final developmental testing to product testing
Determination of product test execution completion criteria>
[bookmark: _Toc384289386][bookmark: _Toc391920694]Test Data
<Specify the test data to be used. Describe the source, volume, and frequency of the data. Also, describe the manual or automated techniques that will be used for manipulating the test data into a form suitable for evaluation, allowing comparison of the results that should be produced to those that are actually produced.>
[bookmark: _Toc384289387][bookmark: _Toc391920695]Recording Results
<Describe how the test results will be captured, recorded, stored, and communicated to all necessary parties, for both passed and failed tests. Identify what artifacts will need to be produced because of the testing activities, e.g. a testing matrix, test cases, defect log, incident/bug report. Also include the process/steps needed when the item fails the test.>
[bookmark: _Toc384289388][bookmark: _Toc391920696]Analyzing Results
<Describe how the test results will be analyzed or quantified. Include the pass/fail criteria and the number of times the various tests should be executed to ensure accurate results.>
[bookmark: _Toc384289389][bookmark: _Toc391920697]Defect Resolution
<Describe how the defects identified during the test execution steps will be recorded, reviewed, and resolved. Identify the criteria for defining the severity and priority (urgency) of the defects and bugs as it relates to the project deliverables. Also, include a process for reviewing and resolving the defects and bugs.>


[bookmark: _Toc384289390][bookmark: _Toc391920698]Unit/System Testing
<Describe any specific requirements needed for unit/system testing to be performed (e.g. hardware/software, staffing, skills training).>
[bookmark: _Toc238536505][bookmark: _Toc283727389][bookmark: _Toc384289391][bookmark: _Toc391920699]Test Risks/Issues
<Describe the risks associated with testing the product and document specific Unit/System Testing risks in the Risk Management Log. Also outline appropriate mitigation strategies and contingency plans.>
[bookmark: _Toc283727390][bookmark: _Toc238536506][bookmark: _Toc384289392][bookmark: _Toc391920700]Items to Be Tested/Not Tested
<Describe the items/features/functions to be tested that are within the scope of this Test Plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also include a description of those items that the project team and project managers have agreed will not be tested.>
	Items to Be Tested
	Test Description
	Test Date
	Responsibility

	
	
	
	

	
	
	
	


[bookmark: _Toc294708668]Table 2 - Items Included in Unit/System Testing
	Items Excluded from Testing
	Description

	
	

	
	


[bookmark: _Toc294708669]Table 3 - Items Excluded from Unit/System Testing
[bookmark: _Toc238536508][bookmark: _Toc283727392][bookmark: _Toc384289393][bookmark: _Toc391920701]Regulatory/Mandate Criteria 
<Describe any regulations or mandates that the system must be tested against.>
[bookmark: _Toc238536509][bookmark: _Toc283727393][bookmark: _Toc384289394][bookmark: _Toc391920702]Test Pass/Fail Criteria
<Describe the criteria used to determine if a test item has passed or failed its test.>
[bookmark: _Toc238536510][bookmark: _Toc283727394][bookmark: _Toc384289395][bookmark: _Toc391920703]Test Entry/Exit Criteria 
<Describe the entry and exit criteria used to start testing and determine when to stop testing.>
[bookmark: _Toc238536511][bookmark: _Toc283727395][bookmark: _Toc384289396][bookmark: _Toc391920704]Test Deliverables
<Describe the deliverables that will result from the testing process (e.g. documents, reports, charts).>
[bookmark: _Toc238536512][bookmark: _Toc283727396][bookmark: _Toc384289397][bookmark: _Toc391920705]Test Suspension/Resumption Criteria
[bookmark: _Toc238536513][bookmark: _Toc283727397]<Describe the suspension criteria used to suspend all or portions of testing. Also describe the resumption criteria used to resume testing.>
[bookmark: _Toc384289398][bookmark: _Toc391920706]Test Environmental/Staffing/Training Needs 
<Describe any specific requirements needed for the testing to be performed (e.g. hardware/software, staffing, skills training).>

[bookmark: _Toc384289399][bookmark: _Toc391920707]User Acceptance Testing 
<Describe any specific requirements needed for user acceptance testing to be performed (e.g. hardware/software, staffing, skills training).>
[bookmark: _Toc283727399][bookmark: _Toc384289400][bookmark: _Toc391920708]Test Risks/Issues
<Describe the risks associated with product testing and document specific User Acceptance Testing risks in the Risk Management Log. Also outline appropriate mitigation strategies and contingency plans.>
[bookmark: _Toc283727400][bookmark: _Toc384289401][bookmark: _Toc391920709]Items to Be Tested/Not Tested
<Describe the items/features/functions to be tested that are within the scope of this Test Plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also, include a description of those items that the project team and project managers have agreed will not be tested.>
	Items to Be Tested
	Test Description
	Test Date
	Responsibility

	
	
	
	

	
	
	
	


Table 4 - Items Included in User Acceptance Testing
	Items Excluded from Testing
	Description

	
	

	
	


[bookmark: _Toc294708670]Table 5 - Items Excluded from User Acceptance Testing
[bookmark: _Toc294708518][bookmark: _Toc294708916][bookmark: _Toc294724204][bookmark: _Toc294724374][bookmark: _Toc294724538][bookmark: _Toc294708524][bookmark: _Toc294708922][bookmark: _Toc294724210][bookmark: _Toc294724380][bookmark: _Toc294724544][bookmark: _Toc294708529][bookmark: _Toc294708927][bookmark: _Toc294724215][bookmark: _Toc294724385][bookmark: _Toc294724549][bookmark: _Toc294708534][bookmark: _Toc294708932][bookmark: _Toc294724220][bookmark: _Toc294724390][bookmark: _Toc294724554][bookmark: _Toc283727402][bookmark: _Toc384289402][bookmark: _Toc391920710]Regulatory/Mandate Criteria
<Describe any regulations or mandates that the system must be tested against.>
[bookmark: _Toc283727403][bookmark: _Toc384289403][bookmark: _Toc391920711]Test Pass/Fail Criteria
<Describe the criteria used to determine if a test item has passed or failed its test.>
[bookmark: _Toc283727404][bookmark: _Toc384289404][bookmark: _Toc391920712]Test Entry/Exit Criteria
<Describe the entry and exit criteria used to start testing and determine when to stop testing.>
[bookmark: _Toc283727405][bookmark: _Toc384289405][bookmark: _Toc391920713]Test Deliverables
<Describe the deliverables that will result from the testing process (e.g. documents, reports, charts). >
[bookmark: _Toc283727406][bookmark: _Toc384289406][bookmark: _Toc391920714]Test Suspension/Resumption Criteria 
[bookmark: _Toc283727407]<Describe the suspension criteria used to suspend all or portions of testing. Also describe the resumption criteria used to resume testing.>
[bookmark: _Toc384289407][bookmark: _Toc391920715]Test Environmental/Staffing/Training Needs 
<Describe any specific requirements needed for the testing to be performed (e.g. hardware/software, staffing, skills training)>


[bookmark: _Toc384289408][bookmark: _Toc391920716]Other Testing
<Describe any specific requirements needed for other required types of testing (e.g. integration, regression, functional, stress, security) to be performed (e.g. hardware/software, staffing, skills training).>
[bookmark: _Toc384289409][bookmark: _Toc391920717]Test Risks/Issues
<Describe the risks associated with product testing and document specific testing risks in the Risk Management Log.  Also outline appropriate mitigation strategies and contingency plans.>
[bookmark: _Toc384289410][bookmark: _Toc391920718]Items to Be Tested/Not Tested
<Describe the items/features/functions to be tested that are within the scope of this Test Plan. Include a description of how they will be tested, when, by whom, and to what quality standards. Also, include a description of those items that the project team and project managers have agreed will not be tested.>
	Items to Be Tested
	Test Description
	Test Date
	Responsibility

	
	
	
	

	
	
	
	


Table 6 - Items Included in Other Required Testing
	Items Excluded from Testing
	Description

	
	

	
	


Table 7 - Items Excluded from Other Required Testing
[bookmark: _Toc384289411][bookmark: _Toc391920719]Regulatory/Mandate Criteria
<Describe any regulations or mandates that the system must be tested against.>
[bookmark: _Toc384289412][bookmark: _Toc391920720]Test Pass/Fail Criteria
<Describe the criteria used to determine if a test item has passed or failed its test.>
[bookmark: _Toc384289413][bookmark: _Toc391920721]Test Entry/Exit Criteria
<Describe the entry and exit criteria used to start testing and determine when to stop testing.>
[bookmark: _Toc384289414][bookmark: _Toc391920722]Test Deliverables
<Describe the deliverables that will result from the testing process (e.g. documents, reports, charts). >
[bookmark: _Toc384289415][bookmark: _Toc391920723]Test Suspension/Resumption Criteria 
<Describe the suspension criteria used to suspend all or portions of testing. Also describe the resumption criteria used to resume testing.>
[bookmark: _Toc384289416][bookmark: _Toc391920724]Test Environmental/Staffing/Training Needs 
<Describe any specific requirements needed for the testing to be performed (e.g. hardware/software, staffing, skills training)>


[bookmark: _Toc294708545][bookmark: _Toc294708943][bookmark: _Toc294724231][bookmark: _Toc294724401][bookmark: _Toc294724565][bookmark: _Toc294708551][bookmark: _Toc294708949][bookmark: _Toc294724237][bookmark: _Toc294724407][bookmark: _Toc294724571][bookmark: _Toc294708556][bookmark: _Toc294708954][bookmark: _Toc294724242][bookmark: _Toc294724412][bookmark: _Toc294724576][bookmark: _Toc294708561][bookmark: _Toc294708959][bookmark: _Toc294724247][bookmark: _Toc294724417][bookmark: _Toc294724581][bookmark: _Toc294708566][bookmark: _Toc294708964][bookmark: _Toc294724252][bookmark: _Toc294724422][bookmark: _Toc294724586][bookmark: _Toc294708571][bookmark: _Toc294708969][bookmark: _Toc294724257][bookmark: _Toc294724427][bookmark: _Toc294724591][bookmark: _Toc294708576][bookmark: _Toc294708974][bookmark: _Toc294724262][bookmark: _Toc294724432][bookmark: _Toc294724596][bookmark: _Toc294708581][bookmark: _Toc294708979][bookmark: _Toc294724267][bookmark: _Toc294724437][bookmark: _Toc294724601][bookmark: _Toc294708590][bookmark: _Toc294708988][bookmark: _Toc294724276][bookmark: _Toc294724446][bookmark: _Toc384289417][bookmark: _Toc391920725]Appendix A: References
<Insert the name, version number, description, and physical location of any documents referenced in this document. Add rows to the table as necessary.> 
Table 8 below summarizes the documents referenced in this document.
	Document Name
	Description
	Location

	<Document name and version number>
	<Document description>
	<URL to where document is located>

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	


[bookmark: _Ref294727617][bookmark: _Toc294708673]Table 8 - Appendix A: References


[bookmark: _Toc292109361][bookmark: _Toc384289418][bookmark: _Toc391920726]Appendix B: Key Terms
Table 9 below provides definitions and explanations for terms and acronyms relevant to the content presented within this document.
	Term
	Definition

	[Insert Term]
	<Provide definition of term and acronyms used in this document>

	
	

	
	

	
	

	
	

	
	

	
	

	
	

	
	

	
	


[bookmark: _Ref294727633][bookmark: _Toc294708674]Table 9 - Appendix B: Key Terms

[bookmark: _Toc295130758][bookmark: _Toc295131703]
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